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1. About This Document

1.1 Version Information
This document provides information for installing, operating, and maintaining IRIS Focus
software.

Table 1 Document Versions

Document Code Date Description

M211850EN-D February 2017 This document. Fourth version of this document

M211850EN-C June 2016 Third version of this document.

M211850EN-B May 2016 Second version of this document.

M211850EN-A January 2016 First version of this document.

1.2 Related Documents

Table 2 Related Documents

Document Code Name

M211850EN IRIS Focus Administrator Guide

M211849EN IRIS Focus User Guide

M211904EN IRIS Focus Release Notes

1.3 Trademarks
HydroClass™ is a trademark of Vaisala Oyj.

IRIS™ is a trademark of Vaisala Oyj.

All other product or company names that may be mentioned in this publication are trade
names, trademarks, or registered trademarks of their respective owners.
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1.4 Documentation Conventions

Warning alerts you to a serious hazard. If you do not read and follow
instructions carefully at this point, there is a risk of injury or even death.
WARNING!

Caution warns you of a potential hazard. If you do not read and follow
instructions carefully at this point, the product could be damaged or important data
could be lost.

CAUTION!

Note highlights important information on using the product.

Tip gives information for using the product more efficiently.

Lists tools needed to perform the task.

Indicates that you need to take some notes during the task.
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2. IRIS Focus Overview
IRIS Focus provides tools for viewing and analyzing weather data received from weather
radars through a web browser quickly and easily.

The displayed data consists of radar products, which are raw signal data from a radar
receiver processed to provide information about current weather conditions. The radar
products measure information such as radar signal reflectivity or rain intensity for analysis
by meteorologists.

The weather data is overlaid on a geographical map that is centered on a selected radar site.
Data is gathered from a single weather radar or a network of radar sites. All data is stored
for 48 hours, and it can be animated on a time line.

Nowcasting performs advection calculations on motion data from radar products to predict
weather movement and severity up to, for example, 2 hours in the future.

IRIS Focus provides live and pre-configured radar products, which differ in how they are
processed within the IRIS architecture, as well as how they are used by the system end user.

• Live Radar Products
Radar signal data that is processed into radar products and displayed in real-time.
Live products allow more control over the weather data presentation in the IRIS Focus
UI. For example, you can change the reflectivity threshold of a selected radar product in
real-time.

• Pre-configured Radar Products
Preset radar products defined and produced in IRIS Analysis and displayed by IRIS
Focus on request.

Chapter 2 – IRIS Focus Overview
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Figure 1 IRIS Focus Main View

More Information

‣ Live Radar Products (page 73)
‣ Pre-configured Radar Products (page 74)

2.1 IRIS Product Family
IRIS Focus provides an intuitive user experience for professional users, such as
meteorologists and analysts. It is closely integrated with Vaisala weather radar systems,
where IRIS Focus forms the visualization front-end and other IRIS components handle radar
control, radar product generation, and data distribution. IRIS Focus retains the proven
quality of Vaisala IRIS back-end processing software, while adding a modern user interface.

IRIS Focus runs on a web server that users can connect to in an enterprise intranet or from
an external location or the Internet. Network connections between the IRIS Focus web UI
and the data processing back-end go through a socket server, a custom protocol over
TCP/IP that delivers radar data from the IRIS back-end services to IRIS Focus. The IRIS Focus
application polls the server for data and displays it on screen.

The following figure shows a setup where IRIS Focus is used as part of a complete Vaisala
weather radar network consisting of 2 radar sites.
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Figure 2 IRIS Focus Data Flow

In this case, IRIS Analysis and IRIS Radar can be considered back-end services for the IRIS
Focus front-end interface. IRIS Focus communicates with IRIS Analysis through a secure
socket server connection.

The components have the following functions:

• IRIS Radar - Operates the radar site and stores data gathered from the radar signals in
RAW format.

• IRIS Analysis - Receives RAW data from IRIS Radar through secure connection and
processes it into displayable radar products.

• IRIS Focus - Polls pre-configured radar products from IRIS Analysis and displays them
on the web interface and generates live radar products from RAW data.

2.2 Licensing
IRIS Focus requires a software license to run. To activate the license, you need a product key.

Vaisala delivers the product key when you purchase the software. If you have purchased the
software and you have not received the product key, please contact Vaisala.

For server deliveries, Vaisala activates the product key in the factory and a Vaisala
representative sends you the key for future reference.

The license is mapped to the hardware of your IRIS Focus server. If your hardware
configuration changes and you need to re-install IRIS Focus, you must request a
replacement license from your Vaisala representative.

License Options

The IRIS Focus license includes the following:

• IRIS Vision
The IRIS Vision license has an unlimited number of seats.
If the license is missing, users cannot log in while admins can log in but cannot access
the map view.
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• IRIS Focus
The IRIS Focus license is required to use IRIS Focus features and products.
IRIS Focus licensing is based on a floating seat pool.

• Nowcasting
The optional nowcasting feature requires a separate license in addition to an IRIS Focus
license.

IRIS Focus Seat-based License

IRIS Focus licenses are available in different configurations. To increase your seat count, you
must replace the current license with a new one by contacting your Vaisala representative.

The seat count defines how many users can access IRIS Focus at the same time. When a user
logs in, they occupy a seat. When a user logs out, the seat is released and the next user can
take it. If a user logs in when all the licenses are reserved, the user is shown IRIS Vision until
an IRIS Focus license is released.

Nowcasting is only available to users with an IRIS Focus seat.

Seat counts within a workstation are browser-based. For one license reservation, users may

view IRIS Focus in as many instances or tabs of one browser, such as Firefoxâ, as they like. If

a user opens IRIS Focus in a different browser, such as Google Chrome™, they reserve one
license for each browser.

More Information

‣ User Management (page 51)
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3. Requirements

3.1 Hardware Requirements
Minimum Hardware Requirements

• Modern 4-core CPU (Intel Xeon E5 series or similar)
• 16GB RAM
• 1 TB HDD

Recommended Hardware Requirements

• Modern 8-core CPU (Intel Xeon E5 series or similar)
• 32GB RAM
• 2x 1 SAS TB HDD in RAID 1 configuration

The pre-installed IRIS Focus system delivery option uses the Dell PowerEdge R430 rack
server unit, which meets the recommended hardware setup. See the Dell product data sheet
for full specifications.

The hardware capacity directly affects the performance of IRIS Focus. Multiple users can be
logged in to IRIS Focus, and each user can have multiple weather and terrain layers rendered
on screen at the same time. Each weather and terrain layer requires some resources from the
system.

For optimal performance, Vaisala recommends running IRIS Focus on a dedicated hardware
server and not in a virtualized environment.

3.2 Software Requirements
Before installing IRIS Focus, your environment must meet the following software
requirements:

IRIS Network

IRIS network, such as an IRIS Analysis instance must be configured correctly to make data
from at least one radar site available for IRIS Focus.

CentOS 7.1

CentOS 7.1 or later DVD/ISO image mounted on your server. The installation script verifies
the version of several core system packages during the installation and updates them from
the mounted media.

IRIS Analysis

The IRIS Analysis server set up provides radar products through a proprietary socket server
connection. The socket server connection is enabled if at least one radar is connected to
your IRIS Analysis server, and the IRIS Analysis server has IRIS software version 8.13.6 or
newer installed. No further configuration is needed.

Chapter 3 – Requirements
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The map projection in the IRIS Focus web application depends on having a single radar or a
group of radar sites to act as a center point to for map rendering.

In most IRIS Focus configurations, the radar product generator is an IRIS Analysis server that
has been set up earlier on the radar site.

If you are unsure about the suitability of your IRIS Analysis server, please contact Vaisala.

For information on configuring IRIS Analysis, see IRIS and RDA Software Installation Manual.

Before beginning the IRIS Focus installation, make sure you know the hostname of your
socket server.

Scan Service

Radar volume data is fetched from the proprietary Scan Service interface and processed into
live radar products within the IRIS Focus application.

The Scan Service does not need to be active during installation.

Figure 3 Generating Live IRIS Products

More Information

‣ Setting up Scan Service (page 28)
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4. Installation

Figure 4 IRIS Focus Delivery Options

Option A Pre-installed system delivery from Vaisala. The "turnkey" option. Place an order
and wait for delivery by Vaisala.

Option B Preconfigured USB stick containing the CentOS operating system and all
required files for installing IRIS Focus.

Option C Downloadable installation packages. Download the required packages to install
IRIS Focus on your server.

4.1 Downloading Installation Packages
1. Connect to Vaisala Sigmet server (ftp://ftp.sigmet.com) using an FTP client. 

The host server allows read access for anonymous FTP connections.

Chapter 4 – Installation
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2. Navigate to /outgoing/releases/IRIS/Focus/<latest version>
3. Download the following files: 

The files are very large. Use a download tool such as CrossFTP that allows resuming
downloads to fetch the packages.

a. IRIS Focus web application package: Vaisala_IRIS_installer-<latest
version>.tar

b. Maps directory: vaisala-iris-maps-v1.zip
c. Terrain data directory: vaisala-iris-terrain-v1.zip

4. If you require the Centos installation image, download it from: 
FTP://FTP.SIGMET.COM/OUTGOING/RELEASES/CENTOS/7.1/CENTOS-7-X86_64-
Everything-1503-01.ISO

You can skip the CentOS installation image if you already have an appropriately
configured CentOS installed.

4.1.1 Verifying MD5 hashes
Each file has an associated md5sum file located in the same download directory.

After downloading the file(s), verify their integrity by checking each file's MD5 hash against
the one provided at the installation site.

1. Do one of the following: 

• In CentOS – Use the pre-installed md5sum command line tool:
md5sum [filename]

• In Microsoft Windows – Use the pre-installed CertUtil utility:
certutil -hashfile [filename] MD5

2. Check that the hashes match completely with the reference hashes at the download
source 
If you see any discrepancies, the downloaded file is likely corrupted.

3. If you see any discrepencies in the hashes, download the mismatching file again.

4.2 Prerequisites for Installation
Before installing IRIS Focus, make sure your environment meets the necessary hardware and
software requirements.
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More Information

‣ Hardware Requirements (page 11)
‣ Software Requirements (page 11)

4.3 Installing CentOS
A prerequisite for installing IRIS Focus is that CentOS is installed on your intended IRIS
Focus system.

This version of IRIS Focus has been tested with CentOS 7.2. We expect IRIS Focus to also
work with later versions of CentOS 7.x.

If you do not have a CentOS system running, select an installation image from Vaisala
Sigmet server (ftp://ftp.sigmet.com/outgoing/releases/centos), and see instructions at
Tecmint Linux Guides (http://www.tecmint.com/centos-7-2-installation/) on how to perform
a CentOS installation.

Install CentOS according to the instructions, with the following changes.

1. Select your installation language.

Chapter 4 – Installation
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2. In Date & Time, set the system clock to Coordinated Universal Time (UTC) by choosing
the following values: 

• Region: Etc
• City: Coordinated Universal Time
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3. In Software Selection, set the server type by selecting the following software
installation options: 

• Base Environment type: Server with GUI 
• Add-ons: Java Platform
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4. In Installation Destination, start manual partitioning: 

a. Select the hard disk.

b. Select I will configure partitioning.

c. Select Done.
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5. Select Click here to create them automatically. 

6. Select the /home partition:

a. Under Desired Capacity, modify the size of the /home partition by typing 50 GiB.

b. Select Update Settings.
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7. Create the /var partition:

a. Select the plus (+) icon. 
The ADD A NEW MOUNT POINT dialog appears.

b. In Mount Point, type /var
c. Under Desired Capacity, set the size of the /var partition by typing 30 GiB. 

The user interface fills in the available server space.

d. Select Add mount point.

8. Select /home. 

a. Under Desired Capacity, increase the size of the home partition (/home) by typing
50 GiB.

b. Select Update Settings.

9. Select /boot.

a. Under Desired Capacity, increase the size of the /boot partition (/) by typing
500 MiB.

b. Select Update Settings.

10. Select /.

a. Under Desired Capacity, increase the size of the root partition (/) by typing
100 GiB.

b. Select Update Settings.

11. Select swap.

a. Under Desired Capacity, increase the size of the swap partition by typing 32 GiB.

b. Select Update Settings.
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12. Create the /srv partition:

a. Select the plus (+) icon. 
The ADD A NEW MOUNT POINT dialog appears.

b. In Mount Point, type /srv
c. Under Desired Capacity, use the remainder of the server space for the /srv

partition by typing 99999. 
The user interface fills in the available server space.

d. Select Add mount point.

e. Select any other dialog box. 
The partition size changes to cover the available space.

13. Select Done.
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14. Check that the partitions are defined as follows: 

15. Select Done > Accept Changes.

16. Select Begin Installation.

4.3.1 Setting the Root Password
The default password is xxxxxxxx.

1. Select ROOT PASSWORD. 
The Root Password window opens.

2. Enter your root password. 
Check the password strength meter. While Vaisala recommends a strong password, the
software does not stop you from entering a weak one.

3. In the confirm text box, re-enter your root password.

4. In the upper left hand corner, select Done to return to the main configuration page. 
If your password is weak, you are prompted to select Done a second time.

In the Installation Summary/Initial Settings page, the text under Root Password says Root
password is set.
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4.3.2 Creating CentOS User Accounts and Finalizing the
Installation

After you have started the CentOS installation, you are prompted to create a non-root user
account.

1. Select USER CREATION.

2. Create an account with the following properties: 

• User name: radarop
• Password: [chosen password]

Figure 5 Creating User Accounts

3. In the upper left hand corner, select Done to return to the main configuration page. 
If your password is weak, you are prompted to select Done a second time.
The installation continues for a few minutes.

4. When prompted, select Reboot.

5. Select LICENSE INFORMATION. 
Accept the license agreement.

6. Select Done.

7. Select FINISH CONFIGURATION.

The CentOS installation is now complete. You are ready to install IRIS Focus.

4.3.3 Configuring the Network for CentOS

1. In the CentOS installation screen, select NETWORK & HOSTNAME.

2. Configure the network according to your organization's requirements.
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4.4 Upgrading Existing CentOS 7 Setups
If you have an existing CentOS 7 system running, you do not have to install a new system
from scratch. Updating the necessary packages to support IRIS Focus is enough.

Take a backup of the system before upgrading so that you can restore it in case anything
goes wrong.

More Information

‣ Backing-up System Configuration (page 61)

4.4.1 Online CentOS 7 Upgrade
If the server is online, upgrade it to the required CentOS 7.1 level.

1. Login as root

2. Enter the following commands:

a. To clean the yum package manager cache directory: yum clean all
b. To list the lists packages that will be updated: yum check-update
c. To download and install the packages: yum update 

This takes some time depending on the amount of packages and network speed.

3. Reboot the system.

4.4.2 Offline CentOS 7 Upgrade
Use a USB stick with CentOS 7.1 on it or a mounted CentOS 7.1 ISO to upgrade a system
offline.

1. Login as root.

2. Modify the file /etc/yum.repos.d/CentOS-Base.repo and comment out all lines
under the [base] repository by entering a # mark at the beginning of each line.
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3. Add the following lines under the [base] repository: 

[base]
name=CentOS- Base-Offline
baseurl=file:///mnt/centos71/ 
enabled=1 
gpgcheck=0

Make sure file:// is in front of the mount point in this file. The path
file:///mnt/centos71/ is the mount point of the CentOS 7.1 ISO image.
If you use an auto-mounted USB stick, use the lsblk command to find the mount
point.

4. Run the update steps in 4.4.1 Online CentOS 7 Upgrade (page 24). 

4.5 Installing IRIS Focus Components
Make sure you have a CentOS 7 server system set up, and that you have received the IRIS
Focus installation files either as a USB delivery or as a download.

All IRIS Focus components are installed at the same time. You must have the IRIS Focus
application installer, map data package, and terrain data package available before you start
the installation.

1. Mount the CentOS 7.1 USB stick or DVD. 
Although CentOS 7 is already set up, the IRIS Focus installer relies on some packages
that are provided by the CentOS repository.

2. Login as root.

3. Unpack the contents of the IRIS Focus installation file on the server, for example to
the /root/IRIS directory. 
These files occupy approximately 40Gb of space unpacked.

4. Navigate to the directory where you downloaded the files.
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5. Launch the ./rsw-installer script. 
The install script requires the following parameters:

./rsw-installer --offline --gis-db-dump [maps directory] --terrain-dir 
[terrain directory] -s [socket server hostname]

• --gis-db-dump – location for the map data
• --terrain-dir – location for the terrain data
• -s – hostname of the socket server that provides radar product data from IRIS

Analysis

If the computer is connected to the internet, you can run the installer with the --
online flag.
Any additionally required CentOS 7 packages are then fetched from the internet

The script proceeds automatically and installs all necessary services, user accounts and
modules required for running IRIS Focus.

Note that the install process can take a significant amount of time, especially as the
application database is first populated with map data. Do not abort the installation if you do
not see progress in a single step for up to 1 hour.

During installation, the following services are created and started:

• monit – Monitoring tool for Unix systems and processes
• HAProxy – Encodes outgoing traffic with HTTPS encryption
• vaisala-radarsw-webapp – IRIS Focus web application
• vaisala-radarsw-geoserver – Map engine for caching and generating base map

layers
• vaisala-radarsw-nowcast-server – Nowcasting server
• vaisala-radarsw-scan-updater-service – Listener for Scan service
• vaisala-radarsw-scan-http-service – HTTP server for Scan service
• vaisala-radarsw-warn-reader – HTTP server for the receiving WARN products

from IRIS

The following users are created:

• radarweb – Restricted user account for running the IRIS Focus web application
• radarscan – Restricted user account for running the Scan Service database
• radargeo – Restricted user account for running the GeoServer map engine
• warnreader – Restricted user account for running the warn service

4.6 Security Settings
IRIS Focus server has a pre-configured firewall.

Ports for SSH access (22), HTTP (80), and HTTPS (443) are intentionally open:
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• SSH can be used for configuration
• HTTP port is used for redirecting to HTTPS
• The application is always used over HTTPS

The server requires access to HTTP and HTTPS for end users. If the system is accessed
through the internet, you should restrict internet access to the SSH port from the internet to
improve system security.

Firewall is configured through CentOS firewalld system. For more information, see https://
access.redhat.com/documentation/en-US/Red_Hat_Enterprise_Linux/7/html/
Security_Guide/sec-Using_Firewalls.html.

4.7 Configuring IRIS for IRIS Focus

4.7.1 Activating the Socket Server in IRIS Radar

Figure 6 IRIS Radar Status Menu

If your system is running IRIS Focus server, you must enable the IRIS Webview option in IRIS
Radar. For more information, see IRIS Radar User Guide.

1. Make sure IRIS has started.

2. In IRIS Radar, select Menus > Radar Status.

3. Enable Select IRIS Webview. 
When enabled, the field shows the status of the server process, as Idle, Running, or
Stopped.
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4.7.2 Setting up Scan Service
Scan Service is a service running on the IRIS Focus server that receives radar scan volume
data (stored in RAW file format) from the IRIS Analysis server and generates live radar
products from the data in real-time. Scan Service is not required for IRIS Focus to function,
but all IRIS Analysis installations support creating radar product data streams for Scan
Service so you should always also configure the Scan Service when you install IRIS Focus.

Figure 7 Radar Data Delivery Paths

Setting up the Scan Service connection requires that you have root access to both the IRIS
Focus and the IRIS Analysis server. During installation, IRIS Focus sets up all necessary
services, databases and user accounts for processing RAW data, but IRIS Analysis must be
configured to send the RAW files to the correct location before IRIS Focus can use them.
This is done by setting the target location on IRIS Focus server as a network Output Device
in IRIS Analysis. The target location on IRIS Focus server is /srv/vaisala/radarsw/
product_raw directory, owned by the radarscan user.

As the RAW files on the IRIS Analysis server are handled by the local root user and RAW files
on the IRIS Focus server by the local radarscan user, you must add the IRIS Analysis root
account’s public SSH key to the IRIS Focus radarscan accepted keys list.

4.7.2.1 Setting up Scan Service On IRIS Analysis server

1. Log on to IRIS Analysis server as root.

2. In the terminal window, type: setup& 
The IRIS Setup utility opens

3. Select Output.

4. Create a new output device:

a. In Number of output devices, increase the number of output devices by 1.

b. Press ENTER. 
A new configurable output device is added to the end of the Output Device list.
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5. In the configuration pane for the new output device, configure the new output device
with the following settings: 

a. Device type: Network

b. Filename format: Native

c. Target directory: /srv/vaisala/radarsw/product_raw
d. User name: radarscan
e. Host name: [IRIS Focus server]
f. Select File > Save.

g. Select File > Exit.
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6. In the terminal window, type: iris & 
The IRIS menu options.

a. Select Menus > Product Output > Device.

b. Select the device you configured in the Setup utility.

c. In the drop down box on the far right of the window, select Headers Only. 

d. In the product list, select any RAW product.

e. Right-click the far right of the product name and select a radar site. 
If needed, deselect any radar sites you do not want to include in the device
configuration.

f. Select Apply.

g. Select File > Save As. 
Define a name for the new Product Output or use the DEFAULT option.

h. Select OK.

i. Select Close.
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7. In the terminal window, restart IRIS: 

service iris start
service iris stop

8. Read the contents from the root account's public SSH key: cat /root/.ssh/
id_dsa.pub

9. Store the printed key string on a file or on the computer clipboard for later use.

10. Launch a one-time SSH connection to the IRIS Focus server. 
This saves IRIS Focus server's hostname in the IRIS Analysis server's known_hosts
file. ssh [IRIS Focus server IP address]

4.7.2.2 Setting up Scan Service On IRIS Focus server

1. Log in to IRIS Focus server as root.

2. If the /srv/vaisala/radarsw/product_raw directory does not exist, create it
with the command: 
mkdir /srv/vaisala/radarsw/product_raw

3. Set directory owner as radarscan in the radarsw user group with the command: 
chown radarscan:radarsw /srv/vaisala/radarsw/product_raw

4. Edit the radarscan user's authorized SSH keys store with the command: 
nano /var/lib/radarscan/.ssh/authorized_keys

5. Append contents you copied from the IRIS Analysis server root account's public key to
authorized_keys, after the last entry. 
This enables file transfer from IRIS Analysis root account to IRIS Focus radarscan
user.

6. Check that the RAW files appear in the /srv/vaisala/radarsw/product_raw
directory on the IRIS Focus server. 
A Scan Service updater service records metadata of the files in an SQLite database,
which is in turn accessed by the IRIS Focus web UI when it generates live radar
products from the data.

4.7.3 Managing Alerts for Significant Weather
In IRIS Focus, a weather event is an occurance of a pre-configured WARN product appearing
in the display.

A weather event becomes an alert when the pre-configured WARN product moves into a
protected area in the display.

To use IRIS Focus alerts, you must define WARN products in IRIS Radar and then draw
protected areas in IRIS Focus.
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Perform the steps in the following sections.

1. Learn about IRIS WARN products. 
See 4.7.3.1 WARN: Warning/Centroid Product (page 32).

2. 4.7.3.2 Setting-up Public Key Authentication (page 35).

3. 4.7.3.3 Configuring WARN Products (page 36).

4. 4.7.3.4 Scheduling WARN Products (page 39).

5. 4.7.3.5 Configuring an IRIS Output Device for WARN Products (page 40).

6. 4.7.3.6 Sending WARN Products from IRIS to IRIS Focus (page 42).

When you have configured the WARN products that are displayed as events in IRIS Focus,
draw protected areas in IRIS Focus so you are alerted when an event enters that area.

See IRIS Focus User Guide.

4.7.3.1 WARN: Warning/Centroid Product

The WARN product uses other IRIS products to detect significant weather.

Example: Detecting Hail

The occurrence of 45 dBZ at 1.5 km above the freezing level is a good indicator of hail in
many mid-latitude locations. Assuming that the freezing level is at 4 km, and you run an
echo TOPS product for the 45 dBZ contour, your pre-configured warning could check if:

• The TOPS product shows 45 dBZ tops at heights greater than 5.5 km. If yes, there is
a high probability of hail.

• So you do not issue an alarm based on a single pixel, a "threshold region" parameter
checks if the region of hail signature at least 10 km2 .

• The VIL for the same region (1 ... 10 km) is greater than 5 mm (or a value determined
from the local climatology of hail).

The WARN product automates this procedure in real time by searching the products for
significant weather, and alerts the operator when an event is detected. The following figure
shows how the WARN product works.
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TOPS of

45 dBZ

HAIL

HAIL

HAIL in AREA_A

Figure 8 HAIL Warning/Centroid

1 Threshold the input product (45 dBZ
TOPS in the example) so that only points
greater than the threshold are considered
(for example, >>5.5 km (3.4 mi)).
The result is a 2-D binary array.

2 Smooth and connect the regions that are
almost touching, and eliminate any
isolated bins.

3 Contiguous regions are identified by a
region finder procedure.
The centroid location and area of each
region is computed.
Regions below the threshold size are
discarded.

4 Determine whether any part of any
region is in a protected area.

5 Display the WARN product as an event
outside protected areas or as an alert
within protected areas.

Warning Message

You can define the content of the message. For example:

2 HAIL Warnings at 11:30:00 in: AREA_A AREA_B
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In this case, HAIL is the user-selected warning text and AREA_A is the user-selected name
of the protected area.

The names and locations of protected areas are defined in the IRIS Setup utility.

The messages are added to the IRIS Message Summary menu.

Warning Criteria

The automatic warning feature can provide alerts for a wide variety of weather phenomena,
such as the approach of a severe storm, turbulence, lightning hazard, or flood potential.

Up to 3 criteria can be used. The thresholding and smoothing is performed separately for
each, then the results are ANDed together so that centroid definition is performed on the
combined field. For example, the additional criterion of the 1 ... 10 km (0.6 ... 6.2 mi) VIL
>>5 mm (0.2 in) could be added to reduce a HAIL warning false alarm rate.

The following table shows some examples of warning criteria. Each criterion, surrounded by
square brackets above, is one task. The results of multiple tasks are ANDed together.

Table 3 Warning Criteria Examples

Criteria Example

Wind shear detection

[Shear >10 m/s/km at 0.5° EL]
AND
[ ... at 0.7° EL]

over an area of 3 km2 (1.2 mi2)

Storm turbulence detection

[Spectrum Width >6 m/s (>19 ft 8 in / s)]
AND
[Reflectivity >20 dBZ]

over an area of 10 km2 (3.9 mi2)

Hail detection

[45 dBZ TOPS >1.5 km (>0.9 mi) above freezing level] 

over an area of 10 km2 (3.9 mi2)

Precipitation surveillance
detection [1.5 to 14 km (0.9 to 8.7 mi) VIL >1 mm (>03⁄64 in)]

over an area of 10 km2 (3.9 mi2)
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Criteria Example

Severe storm detection or
lightning hazard [1.5 to 15 km (0.9 to 9.3 mi) VIL >10 mm (>025⁄64 in)]

AND
[10 dBZ TOPS >8 km (>5.0 mi)]

over an area of 10 km2 (3.9 mi2)

Flash flood warning

[Hourly Rainfall or N-Hour Rainfall >5 mm (>013⁄64 in)]

over an area of 25 km2 (9.7 mi2)

To function effectively, a WARN product must be based on the local climatology and
experience. Vaisala can work with you to develop such a climatology or to better
understand the capabilities and limitations of the WARN product.
Vaisala makes no warranty, either express or implied, that the WARN product can detect
all hazardous weather situations. In no event can Vaisala be held liable for damages of any
kind for failure of the WARN product to issue a warning, or for false alarms that may be
issued by the WARN product.

4.7.3.2 Setting-up Public Key Authentication

To support sending WARN products from IRIS to IRIS Focus, you must add the public key of
the root user of the IRIS machine to the authorized keys list on the IRIS Focus machine.

This allows the files to transfer over the network securely, automatically, and without
passwords.

1. On the IRIS machine, copy the contents of: /root/.ssh/<public_key_file> 
(for example id_rsa.pub)

2. On the IRIS Focus machine, copy the key file to: /var/lib/warnreader/
authorized_keys
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4.7.3.3 Configuring WARN Products

If you wish to be alerted to events entering protected areas you draw in IRIS Focus, you
must configure a WARN product for each tracked event in IRIS Radar.

For more information, see IRIS Focus User Guide.

Use the WARN product configuration menu to specify the message, the area of the threshold
region, and up to 3 products to use as criterion for the warning.

IRIS Focus does not include a WARN product of its own. You must configure WARN
products in IRIS.

1. In the main menu bar, select Menus > Product Configuration.

2. In the main menu bar, select Type > WARN. 
The WARN Product Configuration menu opens.
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3. In Warning Symbol, specify the text used in the warning messages. 
For example, the text may be, HAIL or MBW, S++, or TRW+.
If you define the Warning Symbol with a predefined IRIS Focus Warning Symbol, IRIS
Focus displays the weather with as an icon. If you use a different Warning Symbol, IRIS
Focus displays the weather with the UNKNOWN icon.

Table 4 IRIS Focus Warning Symbols

IRIS Warning Symbol Label IRIS Focus Event Icon IRIS Focus Alert Icon

DOWNBURST

HAIL

THUNDERSTORM

WINDSHEAR

Other Warning Symbol value

4. Enter the minimum size of a thresholded region in the Area in Sq Km field. 
Areas that do not meet or exceed this size are discarded. Enter the desired value in
square km.
For example, for a 3 km by 3 km (1.9 × 1.9 mi) size area, enter 9.
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5. Select the button next to Product Type and Product Name, select up to 3 products to
be examined by the WARN product. 

• Products must have the same maximum product range per the respective
Product Configuration menus.

• Products must have the same resolution per the respective Product
Configuration menus.

• Products must be of a supported data type: dBT, dBZ, dBZc, Height, Kdp,
LDRH, LDRV, R, Rain, RhoH, RhoV, RhoHV, Shear, SQI, Time, VIL, Width,
and ZDR.

Errors are reported at run time in the Radar Status menu.

a. Select the product type. 
The Product Name information is filled in automatically. You an edit the name if you
wish

b. Select the product name. 

The list of product names shows products currently in your system. If the product
you want does not show, run your system until it does show.
Alternatively, chose a different product of the desired type and override the
product name.

c. For each product, use Time values to use products from different tasks or different
runs of the same task. 
Use the plus and minus buttons to increase or decrease the hours, minutes, or
seconds or type a time value in the window.
This field applies only when there is more than one criterion. For example, if the
second criterion has a time of 00:10:00, when the first product becomes available,
the scheduling algorithm searches back in time as far as 10 minutes to find a version
of the second product.
You must know your task schedule. If you use products based on different tasks, you
must set the Time field to some nonzero number or the product does not run. In
general, if all of your product criteria are based on the same task, set all the times to
00:00:00 so that only data from the same run are used.

d. For each product, enter the warning threshold in Threshold. 
The WARN product considers only those values that meet or exceed the threshold.
The units of measure depend on the selected product. For example

• TOPS thresholds are specified in km
• VIL thresholds are specified in mm.

Check the appropriate Product Configuration menu if you are uncertain about
the units of measure.
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For the VVP product, the threshold refers to the divergence in units of m/s per km
(10-3 s-1). When the WARN product is run for the VVP, a warning is generated if the
divergence exceeds this value at any height in the VVP. Strong low-level divergence
over the radar could be an indicator of a microburst. To properly set for microburst
alerts, you must know the local characteristics of the phenomena.

6. Do not configure Protected Areas for Warning Alert. You do this later in the IRIS Focus
display.

7. In IRIS Radar, schedule the WARN product.

a. Select Menus > Product Scheduler.

b. In Add for, select the radar site for which you want to schedule the WARN product.

c. In the list, right-click the WARN product header. 
A list of all available WARN product configurations appears.

d. In the list of WARN product configurations, select the WARN product you just
configured. 
The new product appears in the list in a stopped state.

e. To schedule the WARN product indefinitely, right-click the Status column for that row
and select All.

For more information, see IRIS Radar User Guide.

4.7.3.4 Scheduling WARN Products

You must configure WARN products before you can schedule them.

If you wish to use alerts and protected areas in IRIS Focus, you must schedule a WARN
product in IRIS Radar.

1. Select Menu > Product Scheduler. 
A list of available product types appears.

2. On first line of the menu, select the button next to Add For and select the code for your
local radar.
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3. In the list, right-click the WARN product header. 
A window appears listing the available WARN product configurations.

4. Right click the WARN product header. 
A window appears listing the available WARN product configurations.

a. Select the WARN configuration you created earlier. 
The product appears on the list of scheduled products in a stopped state.

b. Schedule the WARN indefinitely by right-clicking the Status column for that row and
selecting All.

4.7.3.5 Configuring an IRIS Output Device for WARN Products

In IRIS, you must configure the IRIS Focus server as an output device to which IRIS copies
WARN product files. The output device configuration would look something like the
following, except the Menu alias and Recipient host name fields would be filled in with a
name for the output device and with the network address of the FIRE server (don't forget to
save and restart IRIS after making changes to output device configurations):

1. In the IRIS terminal window, type: setup& 
The IRIS Setup utility starts.
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2. In the IRIS Setup utility, select Output.

3. In Number of Output Devices, raise the number of devices by 1.

4. Scroll down to the first unconfigured output device and begin configuring the device
for IRIS Focus WARN products. 

a. For Device type, select Network.

b. For Menu alias type the name of the output device. 
The image shows an example.

c. Recipient host name type the network address of the IRIS Focus Server. 
The image shows an example.

5. Save your changes and restart IRIS to take the changes into effect.
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4.7.3.6 Sending WARN Products from IRIS to IRIS Focus

When you have configured and scheduled the WARN product, you can start sending WARN
products over the network to IRIS Focus.

1. In the IRIS terminal window, type: iris& 
The IRIS Radar application starts.

2. Select Menus > Product Output.

3. In the Device menu, select the IRIS Focus device you want to send products to. 

This is the device you configured in 4.7.3.5 Configuring an IRIS Output Device for
WARN Products (page 40).

4. Filter the list of output products: 

a. For the Site field, select the correct radar site.

b. For the Type field, select WARN.

c. Select Apply.

The WARN products that are generated for this radar site.are shown.

5. Right-clicking the Request column and select the site you want to start sending the
product to. 
In the example above, the THUNDERSTRM WARN product will be sent to the X6T site.
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4.8 Verifying IRIS Focus Installation
After the installation steps are complete, verify the installation.

1. Restart the server. 
IRIS Focus web application is set to launch automatically when the server starts. The
web UI is running at the default HTTPS port, and the following default user accounts
have been created in IRIS Focus during installation:

• Username: admin / password: admin123
• Username: user / password: user123

2. Access the IRIS Focus web UI by opening a browser on the IRIS Focus server and
navigating to https://localhost. 
You should see the login screen for IRIS Focus web application.

3. Log in with the default IRIS Focus user account. 
Make sure the application loads, and the map view is displayed.

4. Verify that Tracking Tool and Cross Section buttons are visible in the application UI. 
This verifies that IRIS Focus features are enabled.

5. Enable the grid lines from Map Features Lat/lon grid. 
Depending on where the map view is centered, you should see slightly distorted grid
lines that are leading away from the equator. This verifies that the map projection is
correct.

6. (optional) If you also configured Scan Service, select Add Product and add a new Live
PPI or Live CAPPI product. 
You should see weather data from the selected time on the screen.

4.9 Activating License – Online
1. Login as root.

2. Run the rsw-show-machine-code command on the IRIS Focus server to get the
locking code specific to the server hardware.
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3. Go to Vaisala License Manager Web at https://licensing.vaisala.com and select Product 
Code in the Login Using field. 

4. Enter your product code and select Login.

5. Enter the locking code in the Request Code field. 
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6. Select Generate. 
A popup window with the license string opens.

7. Select Save to File to save the license string to a file on disk. 
The file is saved by default with the name lservrc.

8. Install the license with the rsw-install-license <location-of-the-
license-file> command.

9. Restart IRIS Focus services with the following command: 

service vaisala-radarsw-webapp restart

10. Log in to IRIS Focus using an administrator account.

11. Select Admin > System > Licensing Management to view information about the license
(seats, end date, and start date).

More Information

‣ Licensing (page 9)

4.10 Activating License – Offline
If the server running IRIS Focus is not connected to internet, you must activate the license by
entering the IRIS Focus server locking code in Vaisala License Manager Web using an
another online computer and then transfer the license file to the IRIS Focus server.

1. Run rsw-show-machine-code > [filename] command on the IRIS Focus server
to get the product code specific to the server hardware. 
This stores the product code string in a file.

2. Copy the file to a removable media and transfer it to the online computer.
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3. Go to Vaisala License Manager Web at https://licensing.vaisala.com and select Product 
Code in the Login Using field. 

4. Enter your product code and select Login.

5. Enter the locking code in the Request Code field. 
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6. Select Generate. 
A popup window with the license string opens.

7. Select Save to File to save the license string to a file on disk. 
The file is saved by default with the name lservrc.

8. Copy the license file to a removable media, such as a USB stick, and transport the file to
the IRIS Focus server.

9. Install the license with the rsw-install-license <location-of-the-
license-file> command.

10. Restart IRIS Focus services with the following command: 

service vaisala-radarsw-webapp restart

More Information

‣ Licensing (page 9)
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5. Upgrade

5.1 Upgrading IRIS Focus 2.1 to IRIS Focus
3.0

The following instructions assume you are upgrading from IRIS Focus 2.1 to IRIS Focus 3.0.

If you have IRIS Focus 2.0, you must upgrade to IRIS Focus 2.1 before you can upgrade to
IRIS Focus 3.0.

IRIS Focus 3.0 requires a new license. If you do not yet have a license, please contact your
Vaisala sales representative.

1. Login as root.

2. Backup the system configuration. 
See 6.13.1 Making a Manual Back-up (page 61).

3. Insert the upgrade USB stick.

4. Copy the file Vaisala_IRIS_installer-3.0.tar from the USB stick to the
server's hard disk drive, for example to the /root directory.

5. Extract the file: tar -xvf Vaisala_IRIS_installer-3.0.tar 

6. Change to the directory created in the previous step: 
cd Vaisala-IRIS-Focus-v3.0.0--xx

7. Run: ./rsw-upgrade 

To view installation command line options, run: ./rsw-upgrade –h

8. Verify the upgrade by running: rpm –qa | grep vaisala 
Check that the rpm name is version 3.0.

9. Activate the IRIS Focus license. 
Depending upon whether or not your server is connected to the internet, see:

• 4.9 Activating License – Online (page 43)
• 4.10 Activating License – Offline (page 45)
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5.2 Upgrading IRIS Focus 2.0 to IRIS
Focus 2.1

The following instructions assume you are upgrading from IRIS Focus 2.0 to IRIS Focus 2.1

IRIS Focus 2.1.0 requires a new license. If you do not yet have a license, please contact
your Vaisala sales representative.

1. Login as root.

2. Backup the system configuration. 
See 6.13.1 Making a Manual Back-up (page 61).

3. Insert the upgrade USB stick.

4. Copy the file Vaisala_IRIS_installer-2.1.tar from the USB stick to the
server's hard disk drive, for example to the /root directory.

5. Extract the file: tar -xvf Vaisala_IRIS_installer-2.1.tar
6. Change to the directory created in the previous step: 

cd Vaisala-IRIS-Focus-v2.1.0--55
7. Run: ./rsw-upgrade 

To view installation command line options, run: ./rsw-upgrade –h

8. Verify the upgrade by running: rpm –qa | grep vaisala 
Check that the rpm name is version 2.1.

9. Activate the IRIS Focus license. 
Depending upon whether or not your server is connected to the internet, see:

• 4.9 Activating License – Online (page 43)
• 4.10 Activating License – Offline (page 45)
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6. Administration

6.1 User Management
Access to different features in IRIS Focus depends on what roles have been enabled for a
user account. For example, the administration features are available to user accounts with
administrator role.

IRIS Focus uses the following roles:

• administrator - Can access administration features
• focus - Can access the full IRIS Focus feature set
• kiosk - Can only access the non-interactive full screen Kiosk mode
• poweruser - Not used
• user - Can access limited application features

To enable all IRIS Focus features for an account, set both user and focus roles for that
account.

IRIS Focus builds on earlier Vaisala IRIS software. The release preceding IRIS Focus was IRIS
Vision, which is included in IRIS Focus as a limited environment that users without a focus
role or a valid IRIS Focus license can use. A user account that has user administrator or role
without focus role set enters the IRIS Vision mode. IRIS Vision does not include features such
as cross-section or live radar products.

Each logged-in user account with focus role reserves one IRIS Focus seat from the license
pool. When the user logs out, the seat is released. If a user with focus role logs in and there
are no IRIS Focus seats left, the user enters the restricted IRIS Vision mode. When a seat is
again available, the user receives a pop-up message that offers the option to switch to IRIS
Focus.

Each user account belongs to one or more organizations. Each organization can have a
subscription to a selected software for a selected number of users. However, you can use
organizations to create subgroups that have separate license pools and manage the license
availability that way.

By default, an administrator account does not have the focus role set to avoid reserving an
IRIS Focus license when performing administration tasks.

More Information

‣ Licensing (page 9)

6.1.1 Managing User Accounts

1. Log in with an administrator account
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2. Select Admin in the upper right corner. 
The Users window opens with tools for adding, editing, and deleting users.

6.1.2 Creating User Accounts After First Install
After a fresh installation, start creating user accounts.

1. Choose which organization you want to create your users in:

• Use the default root organization.
• For more control over license seat allocation, create a new organization in the

Organizations tab.

2. Subscribe the organization to a license pool in the Application Subscriptions tab:

a. Select the radarsw organization.

b. Enter the validity period.

c. Enter the maximum allocated users (licenses). 
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3. Add users to the organization in the Users tab:

a. Add user details.

b. Select an organization for user.

c. Add roles to user

d. Add both focus and user roles to make IRIS Focus features available.

e. To select multiple roles, press CTRL.

The default administrator account does not have the focus role set. This is to avoid
reserving an IRIS Focus license when performing administration tasks.

Figure 9 Users List

6.1.3 Removing User Accounts
When IRIS Focus user accounts are removed from the system database using the Admin
user management functions, the user name of the deleted account remains in the system.
This keeps log files intact, as references to deleted users remain in the audit logs.

IRIS Focus does not allow you to create a new user with a similar user name as an existing
one. This applies even when the account has been deleted earlier.

6.2 Adding/Removing Radars
When new radar sites are added or removed as data sources on the IRIS Analysis server,
radar settings on the IRIS Focus server must be re-syncronized. Settings requiring updates
include updating the radar site location in GeoServer and calculating new map projections.

1. Run radar site setup script: rsw-basemap-site-setup --socket-server
[socket_server_host_name]

2. Restart the IRIS Focus web application service: service vaisala-radarsw-
webapp restart

6.3 Configuring Nowcasting
Nowcasting is enabled by default. However, during installation or later, you can adjust the
nowcasting configuration.

For information on using nowcasting, see IRIS Focus User Guide.

Configuring IRIS Focus for nowcasting includes
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• Enabling nowcasting in the IRIS Focus web application and the nowcasting server.
• Configuring MVF and nowcasting criteria.
• Fine-tune the algorithms.

Most users do not need to adjust the nowcasting algorithms.

More Information

‣ Configuring MVF (page 54)
‣ nowcast.ini (page 79)

6.3.1 Configuring MVF
To use nowcasting, for each radar site you must enable MVF generation and pre-configure
the MVF product to define a product type and product name.

IRIS Focus generates one MVF product per site. If meteorological conditions vary across
your radar sites, you may wish to use different products for each radar site.

For information on radar products and product codes, see IRIS Focus User Guide.

1. Log in to IRIS Focus as admin
2. Select Product Configuration. 
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3. For each radar site, select whether MVF generation is enabled for that site. 
To minimize performance problems, do not enable MVF generation for sites that do not
need the nowcasting feature.

4. For the sites with MVF generation enabled, select the product used to create MVFs. 
The product can be of any data type except V and PHIDP.

Minimize performance problems by avoiding:

• Products that generate too much data, for example, those with large
resolutions.
Vaisala recommends using a CAPPI at 2km height at with a 480x480
resolution.

• Generating the MVF product too frequently.
Vaisala recommends using products that are configured to be created no less
than 10 minutes apart.

For more information on pre-configuring products, see IRIS Radar User Guide and IRIS
Product and Display Guide.

5. Select Save.

More Information

‣ Configuring Nowcasting (page 53)
‣ File Locations (page 60)
‣ vsoweb-override.ini (page 81)

6.3.2 Enabling the Nowcast Server

You must have a nowcasting license to use nowcasting in IRIS Focus.
See 2.2 Licensing (page 9).

After a default installation, the nowcast server is running by default.

When troubleshooting nowcasting, check that the nowcasting is enabled and that the
nowcast server is running.

If you change the configuration, you must restart the nowcast server.

1. Login as root.

2. Go to /etc/vaisala/radarsw/configuration/vsoweb-override.ini.

3. In the [NOWCAST] section of the vsoweb-override.ini file, check that the
nowcast server is enabled: 

nowcast.mvf.run: true
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4. Check the nowcast server URL: 

nowcast.http.server.url = http://localhost:34480/api/v1/mvf/

If you have not changed vsoweb-override.ini, you do not need to restart the
vaisala-radarsw-webapp server.
The nowcast server is running by default. If you have not changed nowcast.ini,
you do not need to restart the nowcast server.

5. Restart the vaisala-radarsw-webapp service by typing: 

service vaisala-radarsw-webapp restart

6. Start the nowcast server by typing: 

service vaisala-radarsw-nowcast-server start

a. To verify that the server starts, type: 

systemctl status vaisala-radarsw-nowcast-server.service

b. Check for the status: 

Active: active (running)

6.3.3 Starting the Nowcast Server

1. Login as root.
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2. Start the nowcast server by typing: 

service vaisala-radarsw-nowcast-server start

a. To verify that the server starts, type: 

systemctl status vaisala-radarsw-nowcast-server.service

b. Check for the status: 

Active: active (running)

6.3.4 Stopping the Nowcast Server

1. Login as root.

2. Stop the nowcast server by typing: 

service vaisala-radarsw-nowcast-server stop

6.3.5 Restarting the Nowcast Server

1. Login as root.

2. Restart the nowcast server by typing: 

service vaisala-radarsw-nowcast-server restart

6.4 systemd
systemd and its logging daemon journald are CentOS 7 components that manage
system services.

systemd manages more functionality than its predecessors, and some of the mechanisms,
such as accessing certain log files, have changed.

In CentOS 7, system logs are not directly accessible as files. Instead, they are read with the
journalctl command.
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6.5 Monit
Monit is a watchdog tool for monitoring Unix systems and processes. IRIS Focus uses Monit
to automatically restart the application or a related process or service if it becomes unstable.

If you do maintenance work that requires you to take the application down, you must first
stop Monit before proceeding further, and restart it after maintenance.

In the command line, the Monit service is called monit.

6.6 HAProxy
HAProxy is a proxying tool that IRIS Focus uses for traffic forwarding within the system and
HTTPS encryption for outgoing traffic.

In the command line, the HAProxy service is called haproxy.

6.7 IRIS Focus Web Application
This is the main web UI of the IRIS Focus system.

In the command line, the IRIS Focus web application service is called vaisala-radarsw-
webapp

6.8 GeoServer
GeoServer is used for caching and generating the base map layers.

In the command line, the GeoServer service is called vaisala-radarsw-geoserver

6.9 Scan Service
Scan Service is the HTTP/REST interface that provides raw data for live radar products.

In command line, Scan Service runs 2 separate services:

• vaisala-radarsw-scan-updater-service – Listener for Scan service
• vaisala-radarsw-scan-http-service – HTTP server for live radar products

that are queried from the IRIS Focus web application

6.10 Stopping, Starting, and Restarting
Services

In CentOS 7, services are stopped, started, and restarted with the service
[servicename] stop / start / restart command.
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To use the service command, you must be a logged in as the root user.

The following example shows how to stop, start and restart the IRIS Focus web application
service. Note that the Monit service starts along with the web application.

Stopping the service

• service monit stop
• service vaisala-radarsw-webapp stop

Starting the service

• service vaisala-radarsw-webapp start
• service monit start

Restarting the service

• service vaisala-radarsw-webapp restart

6.11 Logging
IRIS Focus log files are stored in directory /var/log/vaisala/radarsw/webapp,
which contains:

• Application error log: webapp.log
• Information about application performance: webapp-metrics.log

Older logs are rolled over to separate files and zipped automatically in .gz files. No log files
are deleted automatically.

The logging configuration file is in /etc/vaisala/radarsw/configuration/
logback.xml.

6.11.1 Reading System Service Logs
When diagnosing issues with the IRIS Focus server, you may need to access the log files
from system services using the CentOS 7 Journal tool:

journalctl -u [service-name] -l -f --no-pager
Some useful options for journalctl are:

• -u for showing log entries for a given service
• -n for showing only a given number of recent log lines
• -f for following new log entries being logged
• --no-pager for not using a pager program such as less for the output
• -l to print out full log lines and not ellipsize (shorten) them.

For more information, type man journalctl in CentOS 7, or Using the Journal at RHEL
System Administrators Guide (https://access.redhat.com/documentation/en-US/
Red_Hat_Enterprise_Linux/7/html/System_Administrators_Guide/s1-
Using_the_Journal.html)
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6.11.2 Reading Nowcast Server Logs
The nowcast server logs are useful when diagnosing issues with the nowcast server.

1. Check the status of the nowcast server by typing: 

service vaisala-radarsw-nowcast-server status

2. Check the logs by typing: 

journalctl –f

6.12 File Locations

Table 5 IRIS Focus Application and Configuration Files

File or Directory Description

/etc/vaisala/radarsw/configuration

• gis-override.ini
GeoServer database settings.

• logback.xml
Logging level settings.

• radar_centers.properties
List of stored radar site center points.

Configuration files for IRIS Focus module settings.

The files listed here are the most important.

Some settings have a
default config file and an override file.
For example:

• gis-config.ini
• gis-override.ini

When needed, edit the override file.

CAUTION!

/etc/vaisala/radarsw/
configuration/vsoweb-override.ini

Connection settings for socket server, lightning layers,
nowcasting and so on.

/etc/vaisala/radarsw/nowcast/
nowcast.ini

Configuration files for the nowcast server.

/usr/vaisala/radarsw/configuration Configuration files for helper applications used in IRIS
Focus maintenance.

/var/lib/radarweb Home directory of the radarweb user. The IRIS Focus Web
Application is deployed here.

/var/lib/radarscan Home directory of the radarscan user. The RAW files for the
Scan Service database are stored here.

/var/log/vaisala/radarsw Log files from IRIS Focus web application
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File or Directory Description

/var/lib/radarscan/scans.sqlite SQLite database that contains information on radar volume
scans used in the Scan Service

/var/lib/warnreader Configuration files for events and alerts.

6.13 Backing-up System Configuration
IRIS Focus is backed up automatically using a daily configuration and database backup job
that are run at 02:30 AM server time. On factory settings, the server uses UTC as the time
zone.

Automatic Back-up

Backup is done by the cron job /etc/cron.d/vaisala-radarsw-backup-cron that
launches the /usr/vaisala/radarsw/backup/bin/do-backups script.

The backup script stores the server configuration and application settings database. The
created backup files are zipped and stored in the following directories:

• /srv/vaisala/radarsw/backup/configuration
• /srv/vaisala/radarsw/backup/database

Backups are kept for 180 days, after which they are deleted. Each backup file includes a
timestamp in the format: radarsw-configuration-2015-09-21
02-30-01.tar.gz

6.13.1 Making a Manual Back-up

1. Log in as root.

2. Run: /usr/vaisala/radarsw/backup/bin/do-backups
3. Check that new files are created in the following directories: 

• /srv/vaisala/radarsw/backup/configuration/radarsw-
configuration-<timestamp>.tar.gz

• /srv/vaisala/radarsw/backup/database/database-<timestamp>.gz

6.14 Restoring from Backup
1. Login as root.

2. Stop the IRIS Focus web application and Monit service: service vaisala-
radarsw-webapp stop service monit stop

3. Take a backup of the current configuration: usr/vaisala/radarsw/
backup/bin/do-backups

4. Drop the current database with the rsw-db-tool utility: rsw-db-tool drop-db
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5. Recreate an empty database: rsw-db-tool create-db
6. Switch to the database user account postgres: su – postgres
7. Restore the database contents from a backup file by reading the file contents into the

standard output stream and inserting them in the IRIS Focus database wxdb2: 

gzip --decompress --to-stdout /srv/vaisala/radarsw/backup/database/
database-<timestamp>.gz | psql --set ON_ERROR_STOP=on --single-transaction 
wxdb2

8. Exit the postgres user shell: exit
9. Start the IRIS Focus web application and Monit service: 

service vaisala-radarsw-webapp start service monit start 

6.15 Server Management Software
If you are running server management software on your IRIS Focus server, make sure the
management software's settings do not interfere with your intended network settings.

For example, in Dell PowerEdge servers, the integrated Dell Remote Access Controller
(iDrac) sets a default static IP address for the server when it is first deployed.

On Vaisala preconfigured IRIS Focus systems, iDrac is disabled by default.

6.16 Licensing on Server Restart
Active sessions and their licenses are not stored when the IRIS Focus server is shut down.

When the server restarts, the licensing seats are allocated from scratch to users who log in.
The total number of seats in the license pool is unaffected.

More Information

‣ Licensing (page 9)

6.17 Licensing on Systems with Mirrored
HDDs (RAID 1 or RAID 5)

IRIS Focus licenses are mapped, among other parameters, to hard disk IDs. Removing or
replacing one hard disk in a RAID array can cause unexpected behavior, and you should
renew your license as a precaution when doing so. Contact your Vaisala customer
representatives for further instructions.
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More Information

‣ Licensing (page 9)

6.18 Reactivating the License After Server
Upgrade

The product key in the IRIS Focus license is server-specific. If you upgrade your server, you
must request a new service key and activate the new license.

1. Contact Vaisala and request a new server key.

2. Set-up your new server by performing the steps in the following sections: 

a. 4.3 Installing CentOS (page 15).

b. 4.5 Installing IRIS Focus Components (page 25).

c. 4.7.2 Setting up Scan Service (page 28).

d. 4.8 Verifying IRIS Focus Installation (page 43).

3. Reactivate the license. 
Depending upon whether or not your server is connected to the internet, see:

• 4.9 Activating License – Online (page 43)
• 4.10 Activating License – Offline (page 45)
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7. Troubleshooting

7.1 Missing Or Broken Live Radar
Products

If you encounter issues with live radar products, make sure the RAW files are delivered to
the directory /srv/vaisala/radarsw/product_raw on the IRIS Focus server.

If you do not see any new files in the directory, it means that IRIS Analysis cannot push them
to the directory. Make sure that the configuration in IRIS Analysis matches that described in
4.7.2 Setting up Scan Service (page 28).

If there are recent files but corresponding live radar products are not displayed in the IRIS
Focus web application, there may be errors in the Scan Service system services. Check their
status with the following commands and restart the services if needed:

• service vaisala-radarsw-scan-updater-service status
• service vaisala-radarsw-scan-http-service status

If the services are healthy and running, but live radar products are still not displayed, stop
the Scan Service system services and remove the radar scan information database. IRIS
Focus automatically creates a fresh database and starts populating it with new data, starting
from the most recent scan file.

• service vaisala-radarsw-scan-updater-service stop
• service vaisala-radarsw-scan-http-service stop
• rm /var/lib/radarscan/scans.sqlite
• service vaisala-radarsw-scan-updater-service start
• service vaisala-radarsw-scan-http-service start

7.2 Lightning Layer Empty
If the lightning layer exists in your IRIS Focus application but you do not see any lightning
strikes, verify the following requirements:

1. Check that lightning strikes have occurred at the time of observation

2. Check that the configuration file /etc/vaisala/radarsw/configuration/
vsoweb-override.ini contains the following line: 

lightning.wms.url = [URL received from Vaisala]
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3. Check that your subscription to Vaisala AviCast GLD360 service is active 

If you modify the configuration file, you must restart the vaisala-radarsw-webapp
service with the service vaisala-radarsw-webapp restart command.

7.3 Lightning Layer Missing
If you have subscribed to Vaisala AviCast GLD360 lightning detection service, and you do
not see the lightning layer available in the IRIS Focus application UI after running the rsw-
lightning-configure script, add the lightning layer manually.

1. Log in to IRIS Focus with an administrator account and select Admin.

2. Select Map > Map Layers.

3. Select Add New Layer.

4. In Map Layer Information, enter the following values on the layer properties: 

a. URL: /lightning
b. Layer: lightning:ltg_combined_25
c. Transparent: Checkbox checked

d. SLD URL: https://storm.vaisala.com/geolegends/ltg_combined_25.sld

e. Name: ltg_combined_25.ltg_type
5. Select Save.

6. Select Map > Map View Contexts
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7. Edit the default map context TheMap.

8. Select the newly created lightning layer and set its Z level higher than all base map
layers in the map context. 
Z level defines the drawing order of the layers on the map. Higher values are always
drawn on top.

In the web application, the new layer is listed at the bottom of the radar product selection
list.

7.4 Nowcasting is Unavailable
If you cannot see nowcasting features on your display, it is likely because you either do not
have a license or because nowcasting is disabled.

1. Check that you have a nowcasting license.

a. You must have an IRIS Focus seat to use nowcasting. If you see the IRIS Vision
display, wait until an IRIS Focus seat is available and try again. 
See 2.2 Licensing (page 9).

b. Login to IRIS Focus as an administrator.

c. Select Admin > Licensing Management.

2. Check that MVF is configured for your site. 
See 6.3.1 Configuring MVF (page 54).

3. Login as root.

4. Go to /etc/vaisala/radarsw/configuration/vsoweb-override.ini.

Chapter 7 – Troubleshooting

67



5. In the [NOWCAST] section of the vsoweb-override.ini file, check that MVF
creation is enabled in IRIS Focus: 

[NOWCAST]
nowcast.mvf.run = true

By default, MVF generation is enabled (true).

6. Restart the vaisala-radarsw-webapp service by typing: 

service vaisala-radarsw-webapp restart

7. Start the nowcast server by typing: 

service vaisala-radarsw-nowcast-server start

a. To verify that the server starts, type: 

systemctl status vaisala-radarsw-nowcast-server.service

b. Check for the status: 

Active: active (running)

7.5 Online Help Does Not Display
Correctly in Internet Explorer

If you run the software in Internet Explorer with the compatibility view enabled, the online
help may not display correctly.

To fix the problem, turn off the Display intranet sites in Compatibility view setting.

1. To display the Internet Explorer menu, press ALT.

2. Select Tools > Compatibility View settings.

3. Deslect Display intranet sites in Compatibility view.

Version 3.0 Administrator Guide M211850EN-D

68



4. You may need manage the list under Websites you've added to Compatibility View:

a. Highlight the website address you want to remove.

b. Select Remove.
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8. IRIS Focus Architecture
IRIS Focus reads data in the formats produced by weather radar signal processors.

Usually this data is relayed to IRIS Focus through the signal processing and analysis
component, IRIS Analysis, either as pregenerated radar products or as radar scan source
data files which are processed and displayed as radar products by IRIS Focus.

IRIS Focus only accepts a single data source as its socket server. IRIS Analysis can be
connected to an unlimited number of radar sites and relay their radar products to IRIS Focus.

Figure 10 IRIS Focus Architecture

Each radar product is displayed on top of a map view, which is rendered by a GeoServer
instance that is installed during the IRIS Focus installation. The map terrain and detail layers
are always on the background, and the radar products are drawn on top of them. The user
can change the order of radar product layers in real-time.

Most radar products have editable color scales. Color scales are stored as JSON objects on
the IRIS Focus server and can be reused.

Figure 11 IRIS Focus Layers
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8.1 GeoServer and Maps
The map engine in IRIS Focus uses GeoServer architecture. When reading data from a single
radar site, GeoServer renders the map using Azimuthal Equidistant projection, which means
that all directions and distances are correct when measured from the point of origin, which
is the radar site in this case. When reading data from a composite of multiple radar sites,
Web Mercator projection is used.

The terrain data in IRIS Focus consists of a detailed vector map of Earth, separated into
multiple layers. The base map content is licensed from the collaborative OpenStreetMap
project, which provides all vector shapefiles for the base terrain.

Figure 12 Base Map From GeoServer

To save system resources, the shapefiles are combined into different map detail levels that
are rendered as a single layer where possible. For example, selecting the Full detail map
level does not draw separate layers for terrain, roads, map labels, and other map features.
Instead, all the content has been precompiled into a single layer in the IRIS Focus map
package and then drawn on screen.

When a user opens the map view in IRIS Focus, GeoServer processes the vector data in the
current view area into 256x256 PNG tiles that are displayed in the browser window. New
tiles are calculated and generated every time the user pans or zooms on the map, so moving
on the map may feel a bit sluggish in the beginning. To improve performance, GeoServer
runs a caching component called GeoWebCache that stores the tiles for faster retrieval in
the future.

GeoServer has a management web interface that runs at http://localhost:34180/
geoserver. The default management account name is admin and the password can be
found in the file /etc/vaisala/radarsw/configuration/gis-override.ini.
The password is generated automatically during IRIS Focus installation.

The base map data is stored in a postgreSQL database, which also stores all web application
data.
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8.2 Live Radar Products
When displaying live radar products, IRIS Focus fetches raw radar measurement data from
the back-end and processes it in real-time. This provides hands-on control over the radar
product parameters.

The full raw radar volume data is stored for 48 hours and can be used for on-demand
product generation later.

Figure 13 Live Product Components

Data for live products comes directly from the RAW format files produced by the IRIS
backend.

IRIS Focus reads the RAW data through the Scan Service, which is a read-only HTTP/REST
interface that operates on the IRIS Focus server in port 34280.

The data for the interface is read from a local sqlite3 database on the IRIS Focus server that
contains the RAW data files for the configured live products.

When you select a live radar product in IRIS Focus, the web application accesses the
database and fetches the required data, not only for the current situation but for the whole
recorded segment up to 48 hours. The data is then processed live in IRIS Focus and can be
animated similarly to pregenerated radar products.
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Figure 14 Radar Product Visualized

8.3 Pre-configured Radar Products
Pre-configured radar products are generated by the back-end signal processing
components of IRIS Analysis. IRIS Focus reads the list of products, and allows you to select
which one to display on the IRIS Focus map view.

The radar products and their settings are defined in the back-end, and only displayed in IRIS
Focus. They cannot be edited in the IRIS Focus map view.

There is no upper limit to the number of pre-configured radar products that IRIS Focus can
have.

The raw volume data is not stored for later processing. All the information that is not used in
radar product generation is lost.

Figure 15 Pre-configured Radar Product Components

The radar products are rasterized into 2D bitmap images, based on the back-end signal
processing settings. The images are sent to IRIS Focus web UI through the IRIS Socket
Server interface. The Socket Server uses TCP port 30735 to communicate with IRIS Focus.
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When you select a specific pre-configured product in IRIS Focus, IRIS Focus polls the Socket
Server and loads the image.

The resolution of pre-configured radar products is limited by the capacity of the processing
module that produces them. For example, IRIS Analysis has the following limitations:

• Max number of bins in any ray at any time: 4200
• Max number of rays in a sweep: 1024
• Max number of moments recorded in a sweep: 16
• Max number of sweeps per scan: 40

Figure 16 Live and Pre-configured Product Settings

8.4 Lightning Layer
Vaisala offers an optional subscription service for the Vaisala Global Lightning Dataset
GLD360. GLD360 is a dedicated data stream that measures lightning strikes from the
surface of the Earth, and its data is generated outside IRIS Focus.

GLD360 can be integrated with IRIS Focus and included as an additional selectable lightning
layer in the web UI. From the user's perspective, the lightning layer is similar to other
weather product layers.
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Figure 17 Lightning Layer and Controls

To take the lightning layer into use, IRIS Focus server must be online and your organization
must have an active subscription for GLD360. For information on subscribing to the
GLD360, contact Vaisala Lightning Data Services.

1. Log on to the IRIS Focus server as root.

2. Type the command: 
rsw-lightning-configure -r [admin username] -p [admin
password] -s https://storm.vaisala.com/geolegends/
ltg_combined_25.sld

3. Edit the configuration file vsoweb-override.ini:nano /etc/vaisala/
radarsw/configuration/vsoweb-override.ini to contain a reference to the
Vaisala GLD360 URL you received: 

lightning.wms.url = [URL from GLD360]

4. Restart the IRIS Focus web application service: 
service vaisala-radarsw-webapp restart

8.5 Web Application
The IRIS Focus web application can be accessed with current Internet Explorer, Mozilla
Firefox, and Google Chrome browsers.

It only accepts HTTPS connections, and all requests to the standard HTTP port are
redirected to the HTTPS port 443.
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Encryption

Communication between the browser and the web application is encrypted.

Other data traffic within the IRIS Focus application server is unencrypted. IRIS Focus uses
Jetty as web server software, and HAProxy for handling HTTPS encryption. SSL encryption
has been disabled in HAProxy, and only TLS encryption is supported.

Settings

All application settings are stored in a PostgreSQL database on the IRIS Focus server.

Map and terrain data are stored in the same database.

Certificates

The web application comes with a self-signed SSL certificate that secures the connection
between the IRIS Focus server and the user's web browser. However, the browser displays a
security warning in the browser when you try to access the web application.

You can use the application normally even with the warning, but you should consider
acquiring and using a trusted 3rd party certificate, especially if you plan to offer access to
IRIS Focus outside your organization.

For information on installing SSL certificates, see Jetty SSL Configuration at the Eclipse wiki
(https://wiki.eclipse.org/Jetty/Howto/Configure_SSL).
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Appendix A. Nowcasting
Configuration Files

A.1 nowcast.ini
The following example shows the nowcast.ini configuration file for configuring the
nowcasting HTTP server.

; Algorithm to use.
correlator=trec 

TREC

[trec]
; Number of decimals to keep in data when converting to integers.
; Range:  [0 ; 3]. Default: 2.
input_precision=2

; The value in image that declares a missing/invalid value.
; Default: -999.0.
missing_value=-999.0

; The value in image that declares a not-scanned pixel, outside the aperture 
area.
; Default: -900.0.
not_scanned_value=-900.0

; Minimum measurement aperture coverage (%) in correlation region.
; Range:  [0.0 ; 1.0]. Default: 0.60.
aperture_coverage_threshold=0.60

; Minimum signal value for the pixel to be 'active' and used.
; Default: 10.0.
signal_threshold=10.0
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; Feature box size.
; Range:  > 0 Default: 14
field_feature_box_width=14

; Amount of skip when calculating field values.
; Range:  > 0.  Default: 1 (no skip).
field_feature_box_spacing=1 

; Minimum fraction (%) of active pixels in feature box needed to trigger 
correlation analysis.
; Range:  [0.0 ; 1.0] Default: 0.10
field_signal_coverage_threshold=0.10

; Minimum allowable cross-correlation coefficient.
; Range:  [0.0 ; 1.0] Default: 0.55
correlation_threshold=0.55

; Maximum storm movement between images, search region radius.
; Range:  > 0  Default: 15
speed_limit=15

; Spatial smoothing factor, exp(-d/decay). Used for spreading effect
; of local motion vector to its surroundings.
; Range:  >= 0 (0 == no spatial smoothing) Default: 6
field_spatial_decay=6

; Spatial filtering flag. Whether to discard points that differ from global 
average.
; Range:  0 == NO; 1 == GLOBAL; 2 == LOCAL . Default: 1(GLOBAL)
field_use_spatial_filtering=1

; Feature box size for local spatial thresholding (applied only when using 
local spatial thresholding).
; Range:  > 0   Default: 9
field_spatial_filtering_box_width=9
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; Maximum allowed direction difference from mean motion (applied only when 
using spatial filtering).
; Range: [0 ; 180]  Default: 90
field_spatial_direction_threshold=90

; Maximum allowed speed (mgt*mean_motion) above mean motion (applied only when 
using global spatial filtering).
; Range:  >= 1.0  Default: 3.0
field_spatial_magnitude_threshold=3.0

; Global vector weight applied to local values.
; Range:  [0.0 ; 1.0] (0.0 = no global weighting). Default: 0.25
field_global_weight=0.25

; Method for temporal smoothing.
; Range: 0 == NO_TEMPORAL_SMOOTHING; 1 == HISTORY_WEIGHTING; 2 == 
CHANGE_WEIGHTING.
; Default: 1(HISTORY_WEIGHTING)
temporal_smoothing_method=1

; History weight factor (applied when temporal smoothing is made by using 
HISTORY_WEIGHTING).
; Range:  ]0.0 ; 1.0]  Default: 0.25
temporal_smoothing_history_weight=0.25

; Change weight factor (applied when temporal smoothing is made by using 
CHANGE_WEIGHTING).
; Range:  ]0.0 ; 1.0] Default: 0.33
temporal_smoothing_change_weight=0.33
 

More Information

‣ Configuring Nowcasting (page 53)

A.2 vsoweb-override.ini
The vsoweb-override.ini configuration file contains setting for managing the MVF and
advection used in nowcasting.
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Vaisala has carefully chosen good defaults for the nowcasting configuration.
The raster product, such as PPI, CAPPI, of any intensity moments like Z, R, KDP, or rhoHV
that is used as an input for MVF generation should have:

• As little as possible of ground clutter and the near-radar clear air or particulates (such
as dust) returns.

• The bounding box not smaller than any other raster product produced from this site's
data.

Because the two conditions are contradictory, the easiest way to satisfy first condition is
to use a true (not pseudo) CAPPI product with a height of 1.5 ... 2km , but the longest
range (biggest bounding box) product is a raster product generated from the survey
scans, which usually consist of just one PPI scan and cannot be used to generate true
CAPPI products. You must balance these two conditions.

If there are not enough valid products to generate an MVF request, the iteration is skipped
and the system waits for the next product to arrive from IRIS.

Basic Settings

nowcast.mvf.run defines if MVF generation is enabled in IRIS Focus. By default, MVF
generation is enabled (true).

[NOWCAST]
nowcast.mvf.run = true

The nowcast server URL defines identifies where the nowcast HTTP server runs. The default
value is for a fully local installation, which is the default installation configuration.

nowcast.http.server.url = http://localhost:34480/api/v1/mvf/

The netCDF directory stores MVF generation requests and responses to the Nowcast HTTP
Server in netCDF format as well as internal representations of MVF serialized to disk. This
directory is cleaned periodically by default.

nowcast.netcdf.dir = /srv/vaisala/radarsw/product/nowcast/

Advanced Settings

nowcast.mvf.request.num.rasters defines the number of products sent to the
nowcast server for generating the motion vector field (MVF). Default is 2.

nowcast.mvf.request.num.rasters = 2

Version 3.0 Administrator Guide M211850EN-D

82



nowcast.mvf.product.age.limit.minutes defines the maximum number of
minutes (5 ... 1000) the system goes back in time to find valid products (of the type used to
define MVF generation for a site) to use in generating the MVF. Default is 100.

nowcast.mvf.product.age.limit.minutes = 100

nowcast.mvf.max.gap.minutes defines the maximum acceptable gap in minutes
(1 ... 1000) between products for MVF generation. Default is 30.

MVF is a shift in pixels per time interval between frames of the product which was used to
generate MVF. The interval between advected products could easily be different from the
interval between advected frames. For example, if MVF was generated from the product
which was available every 5 minutes but the interval between advected frames has to me 10
minutes, the MVF shift should be doubled. That MVF scaling is taken into account by scaling
shift in every iteration.

nowcast.mvf.max.gap.minutes = 30

nowcast.product.times.age.limit.minutes defines the time range for
calculating advected product times (2 ... 2880 mininutes. 2880 is the entire two day range).
Default is 100

Advected product times must be evenly spaced (due to the calculation). The time is derived
by dividing the last number of minutes defined in this property by n products found in that
period.

The spacing is used as the time gap between advected products. In most cases, you should
set this value to match the value in nowcast.mvf.product.age.limit.minutes.

nowcast.product.times.age.limit.minutes = 100

nowcast.advection.mvf.age.limit.minutes is the maximum number of minutes
to go back in time to find an MVF when generating advected products. If an MVF is not
found in the time span given, the iteration is skipped and Focus waits for the next product to
arrive from IRIS. Range: 5 ... 1000 minutes. Default is 30.

nowcast.advection.mvf.age.limit.minutes=30

nowcast.advection.time.span.minutes defines the time limit when extending
nowcasted products into the future, in minutes. The normal range is 1 ... 3 hours. Default is
120.

You can raise the time span to as much as 6 hours but this is not recommended as accuracy
becomes more vague as time is extended into the future.
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nowcast.advection.time.span.minutes=120

More Information

‣ Configuring MVF (page 54)
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Glossary

advection
The transfer of a property of the atmosphere, such as heat, cold, or humidity, by the
horizontal movement of an air mass. Advection calculations are used to perform some
of the nowcasting calculations.

Bin
A single sample of weather data detected at a known direction, altitude, and distance
from the radar site. The radial size of a bin depends on decreases with distance, so
bins further from the radar site cover a larger area than nearby bins.

Hydrometeor
A particle of condensed water vapor in the atmosphere. Rain, snow, and hail are
examples of hydrometeors.

MSL
Mean sea level. An average level for the surface of the sea or ocean.

NDOP product
Dual-Doppler velocity product. Combines the velocity measurements from 2 or more
radars to get the wind direction and speed.

Nowcasting
Weather forecasting within the next 6 hours.

NWP
Numerical weather prediction

PRF
Pulse Repetition Frequency measured in Hz (pulses per second). When measuring
PRF, a pulse contains transmit, receive, and dead time phases. PRF affects range
folding and velocity folding detection. Normal PRF values for Doppler radars are up to
1000 Hz. Vaisala radars generally operate around 400-700 Hz. In Vaisala IRIS
products, PRF limits the area displayed in radar images and the maximum measurable
wind speed.

Pulse
A short burst transmission signal sent by the radar, used to measure the weather
activity in atmosphere. The reflection measurements from a pulse are sorted into bins.
See also Bin (page 85).

Range folding
Radar signal echoes from outside the radar maximum range that are incorrectly
displayed within the radar measurement area. Also called range aliasing.

Sweep
A collection of pulses at a constant elevation as the radar rotates around its axis 360°.
After a sweep, the radar usually changes its elevation and starts a new sweep. Each
sweep typically contains the same number of bins independent of the elevation. See
also Bin (page 85).
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Velocity folding
Erroneous readings due to particles in the measurement area exceeding the maximum
velocity detection threshold of the radar system. The measured velocity "wraps
around" to the other end of the scale, resulting in discontinuous readings. Also called
velocity aliasing.

Volume
Complete set of raw measurement data collected from sweeps, that is used to
calculate a model of the atmosphere. The maximum volume is half of a sphere (from
0° elevation upwards), but other shapes are more typical.
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Technical Support

Contact Vaisala technical support at helpdesk@vaisala.com. Provide at least the following
supporting information:

• Product name, model, and serial number
• Name and location of the installation site
• Name and contact information of a technical person who can provide further

information on the problem

For Vaisala Service Center contact information, see www.vaisala.com/servicecenters.

Warranty
For standard warranty terms and conditions, see www.vaisala.com/warranty.

Please observe that any such warranty may not be valid in case of damage due to normal
wear and tear, exceptional operating conditions, negligent handling or installation, or
unauthorized modifications. Please see the applicable supply contract or Conditions of Sale
for details of the warranty for each product.

Recycling

Recycle all applicable material.

Follow the statutory regulations for disposing of the product and packaging.
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